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Warning!
It is essential that you read and understand this entire manual and 
the entire contents of the savvy software Help menu before 
proceeding with your installation and configuration. For 
information and to download manuals and software, go to 
www.driveweb.com.

Warning!
Your use of savvy software and drive.web devices may cause 
motors and machinery to  power up with high Voltages or start or 
operate in an unexpected, dangerous or lethal way. It is essential 
that  you are completely familiar with savvy and all of the 
equipment and the system design before attempting to program or 
edit a program or connect to any live device.

Warning!
You are entirely responsible for the configuration or use of any 
drive.web product. By configuring or using these products you 
agree to indemnify and hold harmless Bardac Corporation, its’ 
employees, directors, officers, distributors and resellers against the 
consequences of  your configuration or use of  the products.

Warning!
Information in this manual is subject to change without notice. You 
are responsible for verifying the proper operation of your smarty 
module. Special care must be taken after loading new firmware or 
installing new options.

Warning!
To avoid permanent damage to your smarty, never exceed any 
min or max values in this manual.
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Product Identification Basic smarty Model dw210
Find firmware version in savvy, choose Get 
Detailed Info from the smarty Contextual 
Menu. See page 10. 

Basic smarty Standard Features
drive.web distributed process control.
10/100Base-T(X) Ethernet, pages 6-8
Field upgradeable firmware
8 flexible I/O: ±10V 16-bit analog in, ±10V 14-bit analog out, digital. in. 
8 flexible I/O: 0-10V 16-bit analog in, 24V digital out, digital in. Page 13.
Plug-in Terminal Blocks 
Compact DIN rail enclosure, pages 5, 6.
±10V Control Reference Outputs, 20mA max, page 7. 
Four +24V & Four 0V terminals for power and control reference, page 7.
Real Time/Date Clock with SNTP network time server synchronization.
E-Mail Notify function block, outgoing SMTP mail server support, page 10.
Basic Control Function Block Library with arithmetic, logic, PI, clamps, 

more. See savvy User Manual, Appendix A, function block listing. 

smarty Software Options 
Software options may be added using savvy. See page 12. See savvy 
User Manual, Appendix A for up-to-date function block listings.

04 ModbusTCP/IP Slave. See page 13.
05 Process Control. Function Block Library 1.
06 Winder Control. Function Block Library 2.  See page 15.
10 Advanced Math. Function Block Library 3. 
11 Encoder Control. Function Block Library 4. Requires encoder 

options 15 or 16, 18, 22 or 23 and 40 or 42. Pages 15, 16.
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smarty Internal Hardware Options 14-24 pages 16-19
Factory installed. Contact us for availability.   15-24 are mutually exclusive.

14 Power over Ethernet. See separate manual HG502612.

15 Isolated Internal Incremental Encoder. 

16 External Encoder Module Port. 

17 ModbusRTU Slave (RS485) isolated port (OEM only option)

18 ModbusRTU Slave(RS485) isolated port + External Encoder i2i port

19 ModbusRTU Master, unisolated and ModbusRTU Slave, isolated

20 ModbusRTU Master (RS485), unisolated (OEM only option)

21 ModbusRTU Master (RS485), isolated (OEM only option)

22 ModbusRTU Master unisolated+External Encoder Port (OEM only)

22 ModbusRTU Master isolated + External Encoder Module Port 

24 Add Six Digital Inputs.

smarty External Module Options see pages 19, 20
40 & 42 mutually exclusive. 45 & 46 mutually exclusive & require 40 or 42

30 115V Digital Input, Relay Output Isolator . See manual HG502622.

31 230V Digital Input, Relay Output Isolator . See manual HG502622.

40 Single Encoder Module 2-24V + marker, 5VDC enc. supply, 2x24V input

42 Dual Encoder Module 2-24V + marker, 5VDC enc. supplies, 2x24V input

45 Encoder Retransmit EIA(RS)485 & 422 compliant.

46 Encoder Retransmit ±24V differential signal out.
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smarty Specials
Generic engineered solutions include required options (in parentheses), 
system configuration and wiring diagram. Contact us for other 
engineered solutions. All options may be added. 

dw210-1101 Open-loop Constant Tension Center Winder (05, 06)
dw210-1102 Closed-loop Dancer Control Center Winder (05, 06)
dw210-1103 Closed-loop Loadcell Control Center Winder (05, 06)
dw210-1104 Slip Core Winder (05, 06)
dw210-1105 Electronic Line Shaft, Speed Lock (05, 11, 16, 42 & 45 or 46)
dw210-1106 Coordinated Drive, Line Master Controller (05)
dw210-1107 Analog Drive Front-End Upgrade (05)
dw210-1108 Electronic Line Shaft, Phase Lock (05, 11, 16, 42 & 45 or 46)
dw210-1109 Electronic Line Shaft, Registration (05, 11, 16, 42 & 45 or 46)
dw210-1110 3 PID Controller w/ integral reset & hold (05)

smarty Installation
Dimensions & Clearances:

Clearances must be provided to promote airflow. Lesser clearances may be 
possible. Monitor the Temperature parameter in the System function 
block. It should not exceed 70℃. Forced air circulation may be required. 
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Depth120㎜	 
[4.72”]

Top & Bottom 
Clearances 

51㎜ (2”)

Width 23㎜
[0.91”]

Height 
104㎜
[4.09”]

 Sides Clearances
25㎜ (1”)
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smarty Installation continued...

Weight: No hardware opts.-176g(6.2oz). W/ PoE & Serial Ports-213g(7.5oz)

DIN Rail Mounting. Use 35x7.5mm rail per IEC 60715 or EN50022.

Power Requirements: Regulated 24VDC ±10%, 100mA plus loads. 
External 1A fuse or current limiting is required! 

Environment: Clean air, Operating temperature, 0C min. to 50C max. 
Storage temp, -20C to 60C. Humidity less than 95% non-condensing. UL/
IEC Pollution Degree 2. Install in a metal enclosure with no RF noise sources.

Ethernet Port MDI 8P8C, “RJ45” jack, 100baseTX and 10BaseT, Full 
Duplex, Auto Negotiation, Auto-MDIX, IEEE 802.3ab. 

USB Port,Currently not used. Support is planned, please call for information

Terminal Wiring: Strip 7mm(0.28”) or use ferrules. Use 0.2mm2 (AWG24) 
minimum. One wire, 2.5mm2 (AWG12) maximum.  Two wires, 1.5mm2

(AWG14) maximum. Two wires with ferrules, 1mm2 (AWG18) maximum.

Terminal Tightening Torque: 0.5 Nm (4.4 in⋄lbs)

Indicator LEDs in front panel. For setup, troubleshooting and monitoring:

Power On Green LED

Fault Red LED. Check power supply, connect with savvy or 
contact us at drive.web for more information.

Ethernet Link Green LED indicates Ethernet connection.

Ethernet Activity Yellow LED-Data transmitted or received.

100BaseTX Green LED connection with 100Base-TX.

PoE Option 14 only, see page 16, product manual, HG502612

Four Yellow Serial Port LEDs, see page 16, 17.

Ground (Earth) Do NOT use for 0V power or control wiring. 
Observe local electrical codes and best wiring practices.
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Important Notes: 

Drawing is confidential for use in 

   creating labels for this order only.

Drawing is scaled 300% actual size.

All circles that appear, "white," 

   are no color (clear).

Background color to flood beyond 

   edges.

See attached drawing HJ502441 for 

   cutout dimensions.

Red color is 19 Fire Red.

Dark Gray is 29 Gray.

Background Gray is 27 Cool Gray.

99.00mm Ref.

Drawing No. Issue: Drawing Title: Drawn by: Property of:

GA502441 1 smarty front label art Ian Bardwell-Jones Bardac Corp.
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HJ502441 smarty front label
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Reference Datum

Label Type 875

15 mil Clear VTP with 5 mil 3M #468 Adhesive

Three (3) Cut-outs

All Dimensions in mm ±0.1 mm

See attached drawing GA502441 for art and color information
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smarty Terminals and Layout
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smarty Ethernet Networking & Programming
Before proceeding, it is important to have a basic 
understanding of Ethernet TCP/IP networks. Assigning an 
invalid or duplicate IP address will cause serious network 
malfunctions! smartys are all shipped with the same IP 
address, 10.189.189.189. Consult your company’s IT 
department for an appropriate, unique IP address.

Find useful networking information. Under the Help menu click on User 
Manual. Scroll down to the Basic Network Administration section. 

Set up Your Physical Ethernet Network - You Will Need:
A standard Category 5e cable with 8P8C/RJ-45 connectors on both ends 

for each drive.web  device and your computer.

For systems with more than one drive.web device, an Ethernet switch 
with ports for all drive.web devices and your computer.

Set up Your Computer - Get savvy

With free drive.web savvy software, easily program and 
monitor your smarty, perform data trending and create 
distributed control systems.

To download the latest version of savvy and to view 
the savvy user manual, go  to www.driveweb.com 
and click on Get savvy.

Java Runtime Environment must be installed to run savvy. There is a 
link on the Get savvy page to download Java for free. 

If you do not have internet access, install savvy and Java from the 
Bardac Infodisk. Browse to the savvy link, off-line installation. 
Contact us for the files or Infodisk.
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Get started with savvy
We strongly recommend you attend our free on-line training 
seminars. To register, e-mail training@driveweb.com or call.

Before proceeding with your systems designs it is very important to 
familiarize yourself  with savvy, the configuration software. 

We strongly recommend you read the introductory guides under 
the Help menu; Getting Started with savvy, Getting Started 
with savvy-SFD, savvy-SFD and the PL series drive.   

Use Create Phantom  in the Directory menu to practice, explore 
all drive.web products and options and design and configure 
off-line. Design systems in Phantom devices and Export Data 
under the Directory menu for later use in live devices. Import 
Data into  phantoms to work off-line. 

Under the Directory  menu, click on Discover All Local Devices.  If 
your smarty is powered up and on the same local network as your 
computer, an icon should appear.  

Discover drive.web devices anywhere on the internet unless they are 
protected by firewalls or other network security devices. Assign a public 
IP address or use a VPN. Under the Directory menu, click on Discover 
Device...  

If the icon at right appears with the red padlock and 
comms-fail indication, a network connection problem 
exists. Check connections, LEDs and that the smarty  
IP address is within your computer’s subnet mask.  

Warning! Changing a device IP address WILL disrupt its 
network connections! If a smarty is communicating with other 
devices or drives you must be prepared for system disruption and to 
remap connections in those devices when changing an IP address. In 
the File menu choose Utility > Remap Export File to remap a dw-
system file with different IP address(es).
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Get started with savvy continued...

Under the File menu, click Administrate > Set IP 
Addresses for System.  Locate the serial number on the 
product  label of your smarty. Enter a unique IP address 
that  is within your computer’s subnet mask and click OK.  
A smarty icon should appear with IP address beneath.  

Hover cursor over a device icon, function block, connection 
or parameter to see contextual information in the Status 
Bar at the window top margin and reveal the Hover Button.

Click a Hover Button or right-click elsewhere in an icon to 
access the Contextual Menu.

In the smarty Contextual Menu, choose Change Name to 
name your smarty for easy identification. Also, a 
powerful Find Parameter... function locates and jumps 
views to a parameter. Simply enter its number, name or 
partial name.

To Import or Export  (load or save) configuration data to or 
from your smarty, use its Contextual Menu.

To Import or Export all configuration and connection data to or from all 
drive.web devices and phantoms in the directory use Directory Menu.

Advanced Users: At the bottom of the 
Setup IP Addresses window, click the 
arrow next to Network Information to 
set Subnet Mask, Router, SMTP mail 
server and SNTP time server IP addresses. 
See the savvy user manual. Note! If the 
Network Information box is expanded, 
this network information will be set in the 
device(s) whose IP address(es) are changed.

savvy views are hierarchical with the Directory view at top. Use the 
navigation arrows in the Status Bar to view the next higher level or go 
backward and forward through a series of views. Note that menus 
change as you navigate. 

drive.web control technology
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Get started with savvy continued...

savvy function may be limited if you do not have the required capability 
level or a device is locked with a password.

Click the smarty icon to view the Device Overview 
screen (Standard savvy, no SFD). Click the Function 
Block Engine icon and if you have options 04 , 17 to 
19, the Modbus icon to view. 

In the Function Block Engine view (Standard savvy, no SFD), click the 
FBE menu and select function blocks in the order that you want them to 
be processed. Processing order is from left to right, then top to bottom.

Click on a function block to view its parameters and functional detail. 

Effortlessly connect between parameters and to  parameters in other 
drive.web devices over Ethernet. 

Under the File menu, choose New Viewer... and then Open Device 
Directory. Now you can click on a parameter, drag a connection and 
drop onto a destination parameter in the other viewer.   

Use parameter Contextual Menus for Get Info, Add to Dock, Copy, 
Connect to… start or end connections, Re-name..., and Re-scale...

Click any blue connection to jump views to the other end.

Use connection Contextual Menus to Change Sample Period… in 
drive.web-over-Ethernet connections. 

Click on parameters to open the Setter Box. Adjust the 
value with convenient graphical buttons or keyboard 
entry.

Most drive.web parameters use 16 bit words allowing 
raw decimal integer values 0 to 65535 or ±32767. 
These raw values are formatted, limited and scaled 
depending on the parameter.  Use Get Info or Re-
Scale to verify or change.
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Modbus Function Block
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Get started with savvy continued...

A blank rectangle connected to or from a parameter indicates a remote 
device is not discovered in savvy. 

Very complex  function block configurations with numerous Ethernet 
connections may produce Timebase Overrun indications at the 
System function block. Performance WILL be affected. In the System 
block Contextual Menu adjust the smarty’s Timebase Setpoint. 
Make a connection from the Program Status parameter to log these 
occurrences or provide warning signals.

savvy with Signal Flow Diagram 
Option - SFD Upgrade

With savvy -SFD , bu i ld sy s tems 
graphically while creating live drawings 
that are stored in your smarty.  

Set borders, drag and drop connections, 
zoom, pan, cross-reference and annotate 
multi-page drawings. 

A separate function block and connection 
listing shows program execution order 
from top down. Change execution order 
by dragging function blocks up or down. 

Upgrading savvy and smarty
Process a credit card or Vouchers on-line or purchase Coupons for use 

off-line. Find the Shopping Cart under the Commerce menu.
Select Upgrade savvy under the Commerce menu.
Right-click on smarty icon and choose Upgrade Device…
To process Vouchers choose Pay>Online Via Vouchers in the 

Shopping Cart. Enter each Voucher code on a separate line.
Process Coupons in the Coupon Manager, under the Commerce 

menu. Enter individual codes in the top box and click the Add button. 
The Coupon is recognized. Click Apply.
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smarty Multi-mode Analog and Digital I/O
I/AO  Terminals 13-16 and 19-22 +25V max, -13V min, 100kΩ 

input impedance. Any combinations; Bipolar Analog Out, Bipolar Analog 
In and/or Digital In.

I/DO  Terminals 23-24 and 27-32 +25V max, -0.6V min, 100kΩ 
input impedance. Any combinations; 24V Digital Out, Unipolar Analog In 
and/or Digital In. 

Analog Input Function Block
16 bit resolution. 

4-20mA Input: Connect a 100Ω resistor 
from the Input terminal to  a 0V terminal, 
set Scaling = 1.6V and Offset = -25%

Bipolar Analog Output Function Block
±10.5V, 10mA max output. 14 bit resolution. Enable “on the fly” 
with the Output Enable parameter. 

Digital Input Function Block
Selectable Ranges 5V, 12V & 24V.

Digital Output Function Block
+24V, 50mA max. Enable Source and/or Sink.  

Source drivers shut down in case of overheating or 
over-current. A warning triangle appears in the 
function block and its Source Status parameter 
indicates Fault. Connect Source Status to a fault 
contingency system for critical applications. Click the 
parameter to reveal a Reset button. Note! Resetting a 
Digital Output briefly resets ALL I/O!
Note! Sink circuits are NOT self-protecting. Digital outputs with Sink 
Enable MUST be connected to  a load that is inherently impedance 
protected, current limiting or fuse protected with a fast acting 0.1A fuse.
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Digital Input 
Range

Turn-On 
Threshold

Turn-Off  
Threshold

5V 2.5V 0.83V
12V 6V 2V
24V 12V 4V
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smarty Option 04 ModbusTCP/IP Slave/Server
Warning! Use of smarty option 04 may cause motors and 
machinery to power up with high Voltages or start or operate in 
an unexpected, dangerous or lethal way. It is essential that you 
are completely familiar with the ModbusTCP/IP protocol and 
all of the equipment and the system design you are working 
with before attempting to use this option.

Supports up to five simultaneous  masters. Further connection 
attempts are refused until a connection is ended. 

Note! You cannot write or force parameters that are read-only or have 
incoming drive.web connections.

ModbusTCP Slave Port 502 is the standard specified 
in the protocol. You may change this to match the 
master in the unusual case that it is non-standard.

Modbus Indirect function blocks with sequentially 
numbered parameters make best use of Modbus 
multiple read or write functions. Enter any parameter 
numbers to read or write with one Modbus operation. 

Directly address any numbered parameter individually. You are NOT 
required to use Indirect parameters.

Supported Modbus Function Codes:

drive.web control technology
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FC Name Effect with drive.web parameters

1 Read Coils Single or sequential parameters. Non-zero = 1, On or True

2 Read Input Discretes Single or sequential parameters. Non-zero = 1, On or True

3 Read Holding Registers Read single or sequentially numbered parameters

4 Read Input Registers Read single or sequentially numbered parameters

5 Write Coil Any single parameter. True or On=1, False or Off=0

6 Write Single Register Write any valid value to any single parameter.

15 Force Multiple Coils Single or sequential parameters. True/On=1, False/Off=0

16 Preset Multiple Registers Write to a single or sequentially numbered parameters

http://www.driveweb.com
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smarty Option 06 Winder Control Library
Accurate speed calibration of all components in a winder system is essential 
before commissioning.

Diameter Calculator Block. An instance of this block is required for 
Taper Tension and Torque Compensator blocks. Associate a 
Diameter Calculator in those blocks. 

Taper Tension Function Block. A positive setpoint reduces web 
tension as the roll diameter increases. 

Torque Compensator Block. Set Forward/Reverse Line Direction 
friction compensation, Unwind/Rewind and Wind Forward/Wind 
Reverse modes. Friction and Inertia Compensator buttons set 
Stiction, Static Friction & more. 

smarty Option 11 Encoder Control Library
Speed Lock and Phase Lock require dual encoders Option 42

ENC Position Set the origin and Base Revs granular resolution for a 64-
bit traverse. Output position around the origin as  16-bit  percentage of 
Base Revs setting, 1 to 65,535.

ENC Position Point Pinpoint 64-bit positions by event or calculation. 
Output has same Base Revs resolution as defined in the associated 
ENC Position block.

ENC Position Monitor Select ENC Position Points or current 
location.  Adjustable Output resolution.

ENC Speed Lock Easily implement a Speed Matched Line Shaft or 
Precision Draw application.

Enc Phase Lock Easily implement a Shaft Angle Follower or Line 
Shaft Lock application.

ENC Registration (Call for availability) Align encoder Z markers and/or 
digital input events from photo-eyes in a printing press for example.
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smarty Option 11 Encoder Control Library continued...

Electronic Line Shaft Examples - Connect Output of ENC Speed 
Lock or ENC Phase Lock to the Feedback parameter in a PI block or 
similar. Connect the PI Output to Trim Input in a Trim  block (option 
05) or similar which controls the follower drive’s speed setpoint. Input 
speed or phase offsets at the Setpoint parameter in the PI block. 

smarty Internal Hardware Options 14 - 23 
14 Power over Ethernet  

Use with a PoE Injector or PoE Ethernet switch. Power your smarty and 
connected devices without a separate power supply. Use with a 24VDC 
power supply for fail-safe power. 

Serial Ports LEDs 
LEDs in smarty front panel indicate data received and 
transmitted at Ports 1 and 2. More on Ports, page 18. 
Custom LED control with option 24, see page 19. 
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Serial Port LEDs
Receive Transmit

2008-03-18
HJ502441 smarty front label
Physical Dim.s & CutoutsBardac 40 Log Canoe Circle

Stevensville  MD 21666
(410) 604-3400 phone
(410) 604-3500 fax

info@bardac.com
www.bardac.com Ian Bardwell-Jonesissue 1 Bardac Confidential

drive.web
smarty

100

1

2

PoE

lOlOl

Reference Datum

Label Type 875

15 mil Clear VTP with 5 mil 3M #468 Adhesive

Three (3) Cut-outs

All Dimensions in mm ±0.1 mm

See attached drawing GA502441 for art and color information

Trim

Enc Phase Lock
PI

Phase Shift 
Input

Drive Setpoint 
Output

Line Speed 

Electronic Line Shaft Example
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smarty Internal Hardware Options 14-23 continued...

Encoder options, 15, 16, 18, 22 and 23 transmit to Port 2. 
The Receive 2 LED is always lit with option 15 or it is lit 
when the remote i2i device is powered-up and connected.

15 Internal Incremental Encoder
Terminals T3-T8 are isolated from the smarty.

Encoder Supply Output, +5Vi, 200mA max. If the 
encoder is powered from a different source, a connection 
from 0V on the encoder to T8 0Vi, is required.

Differential inputs ±2V to ±24V max to 500kHz max

Wiring: Always use twisted pair. Outside 
metal enclosure, use shielded cable with 
individually shielded twisted pairs such 
as Belden 8163. Ground the shield at 
one end with a 360° ground clamp 
where cable enters your metal 
enclosure. Route wiring away from AC 
power or RF noise sources.

Click Channel Monitor button to show 
the actual state of each channel. High 
indicates A or B Voltage is higher than 
its complement, /A or /B.

The Status parameter must read OK 
for proper function. All other 
indications will result in the speed 
Output = 0.00 %.  Channel Fault 
conditions are listed at right. 

For critical applications connect from 
Status to a fault contingency system.
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Encoder Fault Detection

Short Circuit or Open Circuit

-10V<V Common Mode<13.2V

|Vdifferential| < 275~475mV

T3 A

T4 A

T5 B

T6 B

T7 +5Vi

T8 0Vi

Terminals
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smarty Internal Hardware Options 14-23 continued...

15 Internal Incremental Encoder continued...

If Comms Fault is indicated or if the Comms Errors parameter shows 
increasing values, there may be an overload at +5Vi, extreme RF noise 
coupling or an internal hardware fault. Check Wiring notes above or 
contact us at drive.web for assistance.

A Moving Average Filter is incorporated in the function block to reduce 
quantization noise. Higher PPR encoders or speeds may allow the filter 
size to  be reduced. The default 15 Filter Size indicates the speed is 
filtered over a period of  15 ⋄ 4.78ms time intervals. 

16 Port 2 i2i External Encoder(s) 
Intelligent  2-wire Interface receiver. Unpolarized & isolated for easy hook-
up to option 40 or 42, External Encoder Module. See pages 19, 20 and  
separate manual, HG502613.

17-23 smarty Serial Ports See product manual HG502421Iss2.0

ModbusRTU for EIA(RS)485 serial networks. Speeds to 500kb/s. 

Isolated options provide greater rejection of  common-mode noise.

* Indicates OEM-Only options. Please call for availability.

drive.web control technology

smarty HG502573Iss1.4
  www.driveweb.com !            Page 18/20

Option Port 1 T3, T4, T5 Port2 T6, T7, T8

17* Not Used Isolated ModbusRTU Slave

18 Isolated ModbusRTU Slave i2i Encoder T7, T8
19 ModbusRTU Master Isolated ModbusRTU Slave

20* Not Used ModbusRTU Master

21* Not Used Isolated ModbusRTU Master

22* ModbusRTU Master i2i Encoder T7, T8
23 Isolated ModbusRTU Master i2i Encoder T7, T8
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smarty Internal Hardware Options continued….

24 Add Six Digital Inputs at T3-T8. 
+25V max, -0.6V min, 8.2kΩ input impedance. 

Includes function block for custom LED action. 
Find LED Control in the I/O (1) list set. 

See page 12 for Digital Input function block and 
threshold info.

smarty External Module Options 
30 & 31 High Voltage Digital I/O Isolator 

See separate product manual HG502622 for details.

Replace terminal block plugs T17-T24 or T25-T32.  

2 NO relay contacts up to 3A max with shared common 

4 AC Digital Inputs, optically isolated from smarty with shared common

Option 30 has 110VAC inputs, 31 has 220VAC inputs.

40 or 42 Intelligent External Encoder Module Choose only one.  

See separate product manual HG502613 for details. 

Differential Incremental Receivers 
with markers, and fault detection 
±2V min. to ±24V max. 

A and B channels, 500kHz max. 

Z Markers, 6000RPM max. 

Two digital event inputs, 50Hz max. 
Threshold is 8.2VDC ± 7%.
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40 or 42 Intelligent External Encoder Module continued...
Markers and Digital Event Inputs are only used with Enc Registration, 

option 11, Encoder Control Library. Call for availability. 
Convenient DIN rail mounting. Enclosure matches smarty. 
i2i Intelligent 2-Wire Interface transmitter. Easy non-polarized connection 

transmits up to 500 feet on twisted pair wiring. Requires smarty 
option 16, 18, 22 or 23.

Green, power and yellow, i2i transmit LEDs in front panel. 
Add only one option 45 or 46. Retransmits A & B channels.

40 External Single Incremental Encoder Module One encoder and 
5V, 200mA auto-reset fused power output.

42 External Dual Incremental Encoders Module Two encoders & two 
5V, 200mA auto-reset fused power outputs.

45 Encoder Retransmit EIA(RS)485 & 422 compliant.
46 Encoder Retransmit ±24V differential signal out.

drive.web Product Line Overview
dw213 smarty-o with Optidrive Plus AC Drive serial link.
dw215 smarty-yf7(Call for availability) with Yaskawa F7 serial link.
speedy sp Add drive.web power, Modbus comms to a PL/X DC drive.
speedy485 Add drive.web power and ModbusTCP via ModbusRTU. 
savvy-sfd Signal Flow Diagram Option see page 12.
smarty & all drive.web products are designed & assembled in the U.S.A.
Get expert drive.web help. Call or email techsupport@driveweb.com

drive.web Training Courses
Free drive.web online interactive training seminars take about one hour. 
Specialized online and factory training sessions are also available.  
To register email training@driveweb.com or call.
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drive.web 40 Log Canoe Circle, Stevensville, MD 21666 USA. 

Ph. 410-604-3400, Fax 410-604-3500, www.driveweb.com
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